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FACTSHEETS – DEVELOPMENT AND 
REVIEW – KALEIDOSCOPE & SCHN 

POLICY AND PROCEDURE© 
 

DOCUMENT SUMMARY/KEY POINTS 

• This policy outlines the framework for the writing and review of Health and Safety 
factsheets within The Sydney Children’s Hospitals Network (SCHN), consisting of The 
Children’s Hospital at Westmead (CHW) and Sydney Children’s Hospital Randwick 
(SCH), and The John Hunter Children’s Hospital (JHCH). 

• This policy and procedure builds on the Memorandum of Understanding (MOU) that 
exists between the three Hospitals regarding the development and review of factsheets. 

• The published factsheets are available on the SCHN website, with links also available 
on the Hunter New England and Kids Health websites. 

• Staff wanting to develop a factsheet must send a brief proposal to their facility Factsheet 
Coordinator for approval before commencing. 

• All factsheets will be reviewed every three years. The facility Factsheet Coordinator will 
notify reviewers when the review process needs to commence. Reviewers are selected 
for their clinical expertise on the topic. 

• Reviewers will be given two weeks to review an existing factsheet or one month if 
reviewing a new factsheet.  

• Reviewers should use the “Track Changes” function in Word, so that changes can be 
easily identified. 

• Consumer consultation will be undertaken for all new factsheets. The ‘approved by our 
families’ logo will be published on all resources that undergo consumer consultation.  

• Authors should use simple language when developing new factsheets - a readability 
level (Flesch-Kincaid Grade Level) of 8 is preferred. 
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CHANGE SUMMARY 

• Recommend to read the entire document as there are minor amendments made through 
out. 

• 21/04/20: Minor review. Updated to new CHW factsheet coordinator email. 

 
 
 

READ ACKNOWLEDGEMENT 

• All staff who review or intend to develop Factsheets should read and acknowledge this 
document. 

 

 
 
Facility Factsheet Coordinator Contact Details 

 
 
 

Facility Factsheet Coordinator 

The Children’s Hospital at 
Westmead 

Health Promotion Officer 
Kids Health 
The Children’s Hospital at Westmead 
Phone: (02) 9845 3585 
Email: SCHN-Factsheets@health.nsw.gov.au 

Sydney Children’s Hospital  

Health Education Manager 
Sydney Children’s Hospital 
Phone: (02) 9382 1855 
Email: SCHN-SCH-Factsheet@health.nsw.gov.au  

John Hunter Children’s Hospital 

Paediatric Nurse Educator 
Kaleidoscope- Hunter Children’s Health Network 
Phone: (02) 4921 4463 
Email: PatientFactSheet@hnehealth.nsw.gov.au 

mailto:SCHN-Factsheets@health.nsw.gov.au
mailto:SCHN-SCH-Factsheet@health.nsw.gov.au
mailto:PatientFactSheet@hnehealth.nsw.gov.au
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1 Background 

Factsheets are an excellent tool for informing parents, the general public, health professionals 
and students about everyday child health and safety issues. They are presented in a user 
friendly format, making them suitable for a broad audience. Factsheets are an important source 
of information for the public and also increase the profile of each health service.  

The development of paediatric health and safety factsheets is undertaken by the paediatric 
Hospitals within New South Wales: The Sydney Children’s Hospitals Network (SCHN), 
consisting of The Children’s Hospital at Westmead (CHW) and Sydney Children’s Hospital 
Randwick (SCH), and The John Hunter Children’s Hospital (JHCH). Standardised processes 
and communication between these hospitals is vital when developing and approving factsheets. 

This document outlines the framework for the development and review of paediatric health and 
safety factsheets for NSW. An MOU between the three Hospitals exists regarding the 
“Factsheet Development and Review” Policy and Procedure. 

 

2 Health and Safety Factsheet framework policy 

When developing or reviewing a paediatric health or safety factsheet the following points should 
be followed: 

• The need to develop a factsheet must be identified, and authorisation from a facility 
factsheet coordinator must be obtained before proceeding. 

• The person/team that identifies the need, is responsible for creating the content. 
• Each facility must agree to the development of a new factsheet and the agreement should 

include applicability to each facility; CHW, SCH and/or JHCH. 
• Factsheets developed (or reviewed) must: 

o Support evidence based best practice. 
o Reflect legislated practice or NSW Health policy. 
o Adhere to the approval/review process. 
o Be developed/reviewed by key stakeholders (i.e. specialists in the field of concern) and 

consumers. 
o Follow the approved writing style and format. 

• All new factsheets must be forwarded to the facility Factsheet Coordinator for distribution 
to the other paediatric hospitals. 

• Consumer feedback is sought on all patient information publications as required under 
Standard 2 of the National Safety and Quality Health Service (NSQHS) Standards via; 

o an online feedback tool specific to the existing SCHN factsheets. This tool is published 
on the SCHN factsheet page, allowing consumers to give feedback on individual 
factsheets. 

o the SCHN Families Online group. This group reviews all new factsheets, advising on 
presentation, accessibility and content before factsheets are published online. 
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• Factsheets will be reviewed every three years, coordinated by the facility Factsheet 
Coordinator, and re-published onto the SCHN internet site. 

• Only one authorised version of a factsheet will be available on the internet. 
• The Factsheet Committee is responsible for resolving any disputes concerning factsheet 

content. The Committee will provide the final decision. Disputes that are unable to be 
resolved within the Factsheet Committee will be referred to the Director Clinical 
Governance and/or Medical Administration. 

 

3 Factsheet versus an Information sheet 

A factsheet provides generic information for the general public on issues relating to children’s 
health and is made available on the SCHN website. It provides families with a basic 
understanding of a paediatric condition and/or planning for general procedures. Factsheets deal 
with child health and safety topics that parents may want further information on. They are 
generic in nature and provide credible information that is not specific to an individual but useful 
for the population.  

For example, a factsheet may provide a family with an introductory overview of the eyes. The 
factsheet ‘Your baby’s eyes’ gives an introduction to parents on the different stages in which a 
child’s eyes change over time. The information is general and should be easily understood by 
the reader without a verbal explanation from a clinician.  

An information sheet, or as it may often be referred to, a ‘localised or ward information sheet’, 
provides a family and/or patient with specific information surrounding their condition or a 
procedure. This information is typically given by a hospital staff member directly to a parent for 
their own immediate use. Information sheets must follow the SCHN process outlined in the 
‘Publications – Development and Review Framework’ Policy. 

An example of an information sheet could be an introduction to appropriate breakfast foods for 
children with cystic fibrosis; exactly what they should be eating and when, based on their 
treatment. It would require a discussion with a clinician during a clinic appointment and be 
provided as a follow up for when the family is at home. 

If unsure whether your sheet is a factsheet or information sheet please contact Public Relations 
or Kids Health (at CHW) or Health Education (at SCH) to discuss which category is applicable to 
your needs. Standard templates are available for both Information sheets and Factsheets, in the 
Word templates tab. 
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4 The Factsheet Committee 

The Factsheet Committee is responsible for providing initial approval to develop factsheets. The 
Committee, who meet via email, ensure there has been adequate stakeholder input and at 
times, request further review by other stakeholders, particularly if there is a conflict regarding 
the content of a factsheet. The Committee is responsible for resolving disputes over factsheet 
content and will provide the final decision. 

The Factsheet Committee is comprised of the facility Factsheet Coordinator for each Hospital (3 
members in total). The Coordinators are identified at each facility by the Director of Clinical 
Operations, or equivalent at each facility. Medical Advisors have in the past formed a part of this 
committee however given the varied nature of content comprised in the factsheet, medical and 
allied health advisors will be sought as and when is necessary. 

Facility Factsheet Coordinator responsibilities 
The facility Factsheet Coordinators are responsible for coordinating the development and review 
process at their respective hospitals, including the following: 
• New factsheets:  

o Approval of new factsheets. 
o Development and review of factsheet content to meet style and readability guidelines. 
o Co-ordination of review and sign off by appropriate staff with clinical expertise on the 

topic.  
• Existing factsheets requiring review:  

o Co-ordination of review and sign off by appropriate staff with clinical expertise on the 
topic.  

• CHW Factsheet Coordinator responsibilities (in addition to the above): 
o Identification of factsheets due for review. 
o Acceptance of changes made at each facility and formatting of a single final factsheet 

ready for sign off by original author.  

o Undertaking consumer consultation of new factsheets, or factsheets identified by 
reviewers as needing additional consumer feedback.  

 

Factsheet Medical and Allied Health Advisor responsibility 
The Factsheet Medical and Allied Health Advisors will be called upon for:  

• Advising on medical or allied health content, where appropriate.  

• Resolution of disagreements on the medical or allied health content of factsheets. This 
may include appointing additional reviewers for independent advice. Where the advisors 
are not able to resolve the disputed content, the Community Health, Ambulatory, 
Rehabilitation, Population Health and Allied Health (CARPA) Clinical Program Director 
will be asked to act as the final decision maker.  
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5 Developing a new factsheet 

1. Before commencing the draft of a new factsheet, a proposal must be submitted to the 
respective facility Factsheet Coordinator. The proposal should include:  

i. The topic of the factsheet 
ii. An overview of the content the factsheet will include 
iii. The rationale behind the factsheet development 

2. The facility Factsheet Coordinator notifies the submitting author if the proposal is 
approved. If approved, the authors may begin writing the factsheet according to the style 
guidelines in the attached Appendix A.  

3. The author should ensure others within their area of expertise have read and approved the 
draft before submitting it to the facility Factsheet Coordinator with the names of those who 
have developed it. 

4. The facility Factsheet Coordinator forwards the draft factsheet to the other two facilities for 
review. Each facility has one month to complete this initial review. 

5. The other two facility Factsheet Coordinators will in turn forward a notification and the 
factsheet (via email) to an appropriate staff member or Department to review the factsheet.  

6. Any changes made to the factsheet should be tracked by selecting the ‘Track Changes’ 
option in the ‘Review’ menu within Word. 

7. If the reviewer requires an extension of the timeframe, the facility Factsheet Coordinator 
should be contacted as soon as possible. If the timeframe expires and the facility 
Factsheet Coordinator has not heard from the reviewer it will be deemed that there are no 
changes to the document and publication will proceed. 

8. All approved factsheets will be forwarded to the CHW Factsheet Coordinator for final 
processing and placing onto the internet. The CHW Factsheet Coordinator will check the 
title and readability level (refer to the attached Appendix A). 

9. The CHW Factsheet Coordinator can accept minor changes to the factsheet after it has 
been reviewed by the other facilities. Minor changes accepted are minor word 
amendments.  

10. Any major changes will be sent to the author for final approval by the CHW Factsheet 
Coordinator. A major change may include process changes, large sections of text change 
etc. Where major changes are recommended by reviewers, authors must let the CHW 
Factsheet Coordinator know if they approve the changes, and send a final document back 
to the CHW Factsheet Coordinator. 

11. Disputes over recommended changes are governed by the Factsheet Committee. 
12. Once the final document is ready, the submitting author should use the survey at 

Appendix B to seek feedback from the document’s intended audience. If required, the 
CHW Factsheet Coordinator can coordinate consumer feedback through the SCHN 
Families Online group.  

13. Changes suggested by consumers will be incorporated into the final factsheet, where 
appropriate. The final factsheet should be provided directly to the consumers to ensure the 
feedback loop is closed. 

https://www.schn.health.nsw.gov.au/hospitals/get-involved/schn-families-online
https://www.schn.health.nsw.gov.au/hospitals/get-involved/schn-families-online
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6 Reviewing an existing factsheet 

After the CHW Factsheet Coordinator has identified a factsheet due for review, the procedure is 
as follows: 

1. Notification and an editable version of the factsheet will be sent simultaneously to all three 
facilities, either directly to the reviewers from the previous review, or to the other facility 
Factsheet Coordinators if appropriate reviewers at each site are not known.  

2. Facility Factsheet Coordinators are responsible for forwarding the notification and the 
factsheet (via email) to the original respective author and/or contact person/s or 
Department responsible for reviewing that factsheet (i.e. stakeholders).  

3. The reviewing stakeholders should ensure others within their area of expertise have read 
and approved the factsheet before returning it to the facility Factsheet Coordinator along 
with the names of those who have reviewed it. 

4. The reviewer/s will have two weeks to review the factsheet from the time they receive 
notification. 

5. Any changes made to the factsheet should be tracked by selecting the ‘Track Changes’ 
option in the ‘Review’ menu in Word. 

6. If a reviewer requires an extension of the timeframe, the facility Factsheet Coordinator 
should be contacted as soon as possible. If the timeframe expires and the facility 
Factsheet Coordinator has not heard from the reviewer it will be deemed that there are no 
changes to the document. 

7. The reviewed factsheets will be forwarded to the CHW Factsheet Coordinator for final 
processing and placing onto the internet. The CHW Factsheet Coordinator will check the 
content, edits and readability level. 

8. The CHW Factsheet Coordinator can accept minor changes to the factsheet after it has 
been reviewed by the other facilities. Minor changes include occasional word corrections.  

9. Any major changes must be confirmed by the original authors/reviewers and is coordinated 
by the CHW Factsheet Coordinator.  

10. Where major changes are recommended, reviewers must let the facility Factsheet 
Coordinator know if they agree with the changes and send a final, reviewed document 
back to the facility Factsheet Coordinator. 

11. Disputes over recommended changes are governed by the Factsheet Committee. 

12. Where major changes are made, consumer feedback should be sought from the 
document’s intended audience. The submitting author should use the survey at 
Appendix B to obtain this feedback. If required, the CHW Factsheet Coordinator can 
coordinate consumer feedback through the SCHN Families Online group.  

13. Changes suggested by consumers will be incorporated into the final factsheet, where 
appropriate. The final factsheet should be provided directly to the consumers to ensure the 
feedback loop is closed 

 

https://www.schn.health.nsw.gov.au/hospitals/get-involved/schn-families-online


Policy No:  2017-067 v2 
Policy:  Factsheets – Development and Review – Kaleidoscope & SCHN 

Date of Publishing:  21 April 2020 11:31 AM  Date of Printing: Page 9 of 14 
K:\CHW P&P\ePolicy\Apr 20\Factsheets Development and Review - Kaleidoscope_SCHN.docx 
This Policy/Procedure may be varied, withdrawn or replaced at any time.  Compliance with this Policy/Procedure is mandatory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright notice and disclaimer: 

The use of this document outside Sydney Children's Hospitals Network (SCHN) or its reproduction in 
whole or in part, is subject to acknowledgement that it is the property of SCHN and Kaleidoscope 
Children’s Health Network (KCHN). Everything practicable has occurred to make this document accurate, 
up-to-date and in accordance with accepted legislation and standards at the date of publication.  SCHN is 
not responsible for consequences arising from the use of this document outside SCHN. A current version 
of this document is only available electronically from the Hospitals.  If this document is printed, it is only 
valid to the date of printing. 
  



Policy No:  2017-067 v2 
Policy:  Factsheets – Development and Review – Kaleidoscope & SCHN 

Date of Publishing:  21 April 2020 11:31 AM  Date of Printing: Page 10 of 14 
K:\CHW P&P\ePolicy\Apr 20\Factsheets Development and Review - Kaleidoscope_SCHN.docx 
This Policy/Procedure may be varied, withdrawn or replaced at any time.  Compliance with this Policy/Procedure is mandatory. 

Appendix A: What do authors of factsheets need to know? 

Readability 
The facility Factsheet Coordinators will be responsible for assessing the factsheet for its 
readability grade. This will be done using the readability (Flesch-Kincaid Grade Level) function 
available in Microsoft Word. Where factsheets have a readability grade of greater than 8 the 
facility Factsheet Coordinators will make minor changes to the factsheet in order to improve the 
readability. The amended version will then be approved by the factsheet committee. 

What does the readability level mean? 
The Flesch-Kincaid Grade Level test bases its rating on the average number of syllables per 
word and words per sentence. A readability grade of 8 means a US eighth grader can 
understand the document. 

How do I check the readability level? 
In Microsoft Word 2010 information about the reading level of a document, including Flesch-
Kincaid Grade Level readability scores is an optional feature under spelling and grammar 
checking.   

In order to set up this feature, please follow the steps below: 

1. Click the File tab, and then click Options.  
2. Click Proofing.  
3. Under When correcting spelling and grammar in Word, make sure Check grammar 

with spelling is selected.  
4. Select Show readability statistics.  

After you enable this feature, open a file that you want to check, and check the spelling. When 
Word finishes checking the spelling and grammar, it displays information about the reading level 
of the document. 

For computers that have a previous version of Microsoft Word, please follow the steps below: 

5. Go to Tools and then click on Options 

6. Set the spelling and grammar tabs to grammar and style from the drop down and click ok 

7. Then, open Tool>Spelling and Grammar>Correct all spelling and grammar then click ok to receive 
the readability report. 
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Tips for writing new factsheets 
Key points 

• Plagiarism is not acceptable 

• Copyright laws protect people’s rights to original publications 

• Factsheets that will be common to two or more facilities must not include information 
specific to an individual facility. Individual facility specific information will be removed 
before publishing on the internet. 

 

Aiming for the correct readability level 

• Target your factsheet to a reading grade level of 8.  This means, KEEP IT SIMPLE and 
avoid words that are not commonly used by the majority of the population (see the section 
on “how do I check the readability level” for more information). 

• Replace complex words with ‘simpler’ terms.  Readers can become frustrated and 
disinterested in the material if they don’t understand the words used.  It is best to use 
words with less than three syllables.  Some examples include: 

o “doctor” instead of “physician” 

o “needle” instead of “injection” 

o “cream” instead of “ointment” 

o “use” instead of “utilise” 

o “about” instead of “approximately” 

o “pierce” instead of “penetrate” 

• When giving directions, be specific. For example, “give your child an extra 250mL of water 
each day”, rather than “give your child an extra bottle of water each day”. 

• If possible include a labelled diagram or pictures, with appropriate references.  

• Use layman's terms where possible.  Where medical terminology must be used, please 
include a simple explanation. 

• Use short sentences averaging 10 words. 

o Address one concept at a time, presenting only the most relevant information.  

o Place important information either at the beginning or at the end.   

o Sequence your information logically.  This may be done by the use of: 

 steps (e.g. 1, 2, 3) 

 a time line 

 a table or diagram 

 topics (e.g. main topic and sub-topic headings).  Headings help give an 
ordered look to material and helps readers locate information quickly. 
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• Avoid sentences with double negatives. Positive statements are more motivating.  For 
example, instead of “Do not eat non-nutritious snacks” you could write “Choose snack 
foods that are high in nutrients”. 

• Avoid abbreviations unless they are common ones. 

• Use short paragraphs. 

• Discuss only 1 or 2 ideas or subjects per paragraph. 

• Use positive rather than negative terminology e.g.  

o Positive = "Your teething baby needs extra comfort be patient and loving" or "Store 
poisons in a cupboard out of your child's reach". 

o Negative = "Don't be impatient with your teething baby" or "Don't keep poisons within 
reach of children".  

• Refer to the child in the second person, e.g. `your child' instead of `the child'. 

• Refer to the reader as ‘you’ rather than ‘I’ (e.g.: “What can you do to help?” instead of 
“What can I do to help?”). 

• Check your material by having other health professionals and parents read it to give you 
feedback. 

• Make sure that your wording is inclusive and does not always refer to nuclear heterosexual 
families.  

NOTE: A helpful online tool for improving readability of text is available at 
http://www.hemingwayapp.com/ . Cut and paste your text into the website and it will make 
suggestions for where your text may be simplified or improved. 

 

Sensory information 
Sensory information should be used wherever possible to advise the child of what they will feel 
during a procedure and any coping strategies they can employ. Analogies are useful in 
describing what a procedure will feel like. 

• A sentence without sensory information could read: 

Your child will have an IV drip inserted. 

• A sentence with sensory information and coping strategies could read:  

You child will have an IV drip inserted. This may feel like a bee sting and it is good to 
encourage your child to take deep breaths while this is happening. 

For an example of an existing factsheet which includes sensory information, click on the 
following link: http://www.schn.health.nsw.gov.au/parents-and-carers/fact-sheets/childrens-
painful-procedures-and-operations 

 

 

 

 

http://www.hemingwayapp.com/
http://www.schn.health.nsw.gov.au/parents-and-carers/fact-sheets/childrens-painful-procedures-and-operations
http://www.schn.health.nsw.gov.au/parents-and-carers/fact-sheets/childrens-painful-procedures-and-operations
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Contacts 

• List any contacts that might be of assistance. 

• Web addresses may also be of use.  

 

 

Remember box 
The layout of the factsheet is such that it concludes with a REMEMBER section.  This box 
should not provide any new information, but simply highlight the most important points of the 
document.  These should be presented as three to five points to remember. 

 

 

Suggested headings for factsheets 
Below are some suggested sub-headings that have been used in previous factsheets.  You may 
find the following helpful in keeping the factsheet clear and simple:    

For Diseases/conditions 

Why does it occur?  What is it?    How common is it? 
What causes it?   What is the treatment?    How does it spread? 
What are the symptoms? What to do?     Can it be prevented?  
How do you get it?   What is the problem?   First aid 

For procedural and sensory information 

What is the procedure?   Why is it necessary?   How long will it take? 
What will it feel like?  What are some coping strategies? 
How will your child feel afterwards? 

 

Format 
Factsheets should be written using the Word factsheet template. Staff from within the SCHN 
Network are able to access this via their Word program within the applications package. Staff 
from KCHN will need to ask their Factsheet Co-ordinator for a copy of the template. 

To find this template in Word, please follow the steps below: 

1. Click the File tab, and then click New.  
2. Click My templates.  
3. Then choose the tab titled SCHN Preferred Designs. 
4. Select the icon titled Factsheet  logos 

The draft copy must also include the name of the author, the reviewer and a contact person for 
reviewing the factsheet in the future.  These details will not be included on the website; however 
they will be on file for future reference.  Drafts should be e-mailed to the appropriate facility 
Factsheet Coordinator depending on where you are located. 

Ensure that any photos used represent a diverse population, including various carer and family 
compositions and skin tones. 
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Appendix B: Factsheet Consumer Feedback Form 

Thank you for taking the time to help us make our draft publications better.  

We will use your feedback to ensure that our information meets the needs of our patients, 
parents and families. 

Please read through the document and then answer the questions below.  

All feedback and comments are welcome. However, it would assist if reviewers could consider 
the following:  

Does the design help you to 
better understand the 
information? 
 
 
Is this easy to read? 
 
 

Yes          
No 
 
 
 
Yes          
No 
 

Comment: 
 
 
 
Why or why not? 

Was the information helpful? 
 
From this, can you explain 
what you are supposed to do 
next? 
 

Yes          
No 
 
 

Comment: 
 
 
 
 

Is there any important 
information missing? 
 
What is it? 
 

Yes          
No 
 
 

Comment: 
 
 

Are there any words that are 
too long or too complicated? 
 
What are they? 
 

Yes          
No 
 
 

Comment: 
 

If there are pictures. Are they 
useful?  
How could they be improved? 

Yes          
No 
 

Comment: 

Is it clear where to seek 
further information? 

Yes          
No 
 

 
 
 

Any other comments? 
 

  
 
 
 
 

 
Thanks so much for your feedback! If you’re happy for us to contact you about your comments, 
please write your name and email or phone number below: 

Name:    _____________________________ 

Email / Phone number:   _____________________________ 
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